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TASKE ACD Monitor

The TASKE ACD Monitor is a call center monitoring application that reports both real-
time and historical call center activity for Pilots and Pilot Groups. A Pilot is a dialable
number that accesses a group of answer positions such as agent or extension groups.
A Pilot Group is used strictly for reporting and monitoring purposes in TASKE
applications. This is a group of Pilots given a single identifying number that is trackable
in reports and the ACD Monitor. The application operates in two modes: Real-time and
Replay.

The Real-time mode displays call center activity that spans the past 12 hours. Call
center statistics are divided into three sections, Now, Last Hour, and Last 12 Hours.
Updated constantly, the Now statistics provide a dynamic view of the current call center
activity. The Last Hour and Last 12 Hours reports provide shift overview statistics.
Viewing the Last Hour reports provides an overview of the call center activity for the
past 60 minutes and the Last 12 Hours reports provide an overview of the past 12
hours.

The Replay mode is an animated review of a 24-hour period that shares the reports of
the Real-time mode. Using the same Now, Last Hour, and Last 12 Hours reports, users
select a date with logged call center data. The information for the day is replayed in a
real-time simulation.

The ACD Monitor Interface

Together, the Menu Bar, the Main Control Panel, and the Pilot Information Display Area
(PIDA) comprise the ACD Monitor interface. The interactive interface reports Pilot and
Pilot Group information numerically, graphically, and tabularly.

The Menu Bar

Spanning the top of the ACD Monitor window, the menu
bar contains four menus that provide keyboard and

mouse access to the functions of the TASKE ACD Monitor. The four menus of
the menu bar are File, View, Monitor, and Help.

File Menu

Access the Exit command from the File menu. This command closes the TASKE
ACD Monitor application.

View Menu
Use the View menu to toggle between the Real-time and Replay modes. Use the
Next Window and Previous Window options to jump between the sections of the
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ACD Monitor window.

Monitor Menu

Click Select Pilot/Groups... from the Monitor menu to access the Pilot/Group
Selection dialog box where the Pilots and Pilot Groups are selected for
monitoring. Additionally, use the Monitor menu to view the Now, Last Hour, Last
12 Hours, Agent Queue, and Agent Map reports for specific Pilots and Pilot
Groups.

Help Menu

Use the Help menu to access the TASKE ACD Monitor online help and to view
version and copyright information for the application.

Keyboard Shortcuts
Use the keyboard shortcuts in the following table to maneuver throughout the
TASKE ACD Monitor application.

ALT+F = Accesses the File menu
ALT+V = Accesses the View menu
ALT+M = Accesses the Monitor menu
ALT+H = Accesses the Help menu
CTRL+T = Access the Real-time mode
CTRL+R = Access the Replay mode
CTRL+L = Access the Pilot/Group Selection dialog box
F2 = Jump to the next window section
Shift+F2 = Return to the previous window section
Space = Selects the highlighted button on a Pilot Panel
Tab = Go to the next button on the Pilot Panel
Shift+Tab = Go to the previous button on the Pilot Panel
Application key = Access agent properties menu from the Agent Queue grid

and the Agent Map grid

The Main Control Panel

The Main Control Panel is located on the left side of the ACD Monitor window.
This section of the window is responsible for:

� Mode selection
� Display of system date and time in the Real-time mode
� Pilot list display and setup
� Date selection in replay mode
� Replay control
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Mode Selection

The two buttons located at the top of the Main Control Panel
are the mode selection buttons. These buttons toggle between
the Real-time and Replay modes.

Date and Time

In the Real-time mode both the current date and time are
displayed for read-only purposes. In the Replay mode, the date
is provided in a box that allows for the selection of the replay
date and the time displays the time of day that is being
replayed.

Pilot Monitor List
The Pilot Monitor List displays the Pilots and Pilot Groups being
monitored. Clicking the Pilots/Groups button accesses the
Pilot/Group Selection window where Pilots and Pilot Groups
are added or removed from the Pilot Monitor List. The Pilot
Monitor List provides a button for each Pilot and Pilot Group
selected in the Pilot/Group Selection window. Select one or
more Pilots from the Pilot Monitor List to display the Pilot
information in the PIDA.

Replay Date Selection

Use the date box in the Replay mode to select a date for
the data replay. Double-click in the date box to choose a
date from the calendar in the Select Dates dialog box.

Replay Control

In the replay mode set the replay speed and control the
replay of data on the Main Control Panel. Similar to VCR
controls, the replay controls maneuver throughout the
day's data. In addition, use the Trigger button to pause the
replay at a specific time.

The Pilot Information Display Area

Occupying the window area to the right of the Main Control Panel, the Pilot
Information Display Area (PIDA) presents statistical and performance information
for Pilots and Pilot Groups based on queue and agent activity. The information
displayed in the PIDA is dependent on the Pilots and Pilot Groups selected from
the Pilot Monitor List. Information is presented numerically, graphically, and
tabularly in both the Real-time mode and the Replay mode.
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Selection of a Pilot or Pilot Group from the Pilot Monitor List displays the Pilot
Panel for the selection in the PIDA. If none of the Pilots or Pilot Groups are
selected from the Pilot Monitor List, the Pilot Panels for all of the monitored Pilots
and Pilot Groups are displayed in the PIDA.

Pilot Panels house the graph control buttons that provide call center statistics
and performance information. For those graph control buttons that represent a
call center statistic, the numeric value of the statistic is visible on the button.

Clicking any of the graph
control buttons provides a
graphical or tabular view of the
call center information. The
graph control buttons are
arranged on the Pilot Panel by
time: Now, Last Hour, and Last
12 Hours.

To aid in the global
assessment of the call center
operations, multiple Pilots and
Pilot Groups can be selected
from the Pilot Monitor List and
viewed simultaneously. The

PIDA self-scales to accommodate multiple Pilots. When there is more information
than the PIDA can display, a scroll bar is provided for viewing the Pilot
information that cannot be displayed.

The view of each Pilot and Pilot Group in the PIDA is customizable to eliminate
unnecessary screen clutter. The Pilot Panels in the PIDA constantly display the
Now statistics, but the Last Hour and Last 12 Hours information is expandable
and collapsible as needed. Clicking a graph control button on a Pilot Panel
accesses a graphical or tabular report. The display of the reports are optional for
each displayed Pilot or Pilot Group and only one report per Pilot or Pilot Group
can be displayed at a time.

Pilot/Pilot
Group Name

Now
Statistics

Last Hour
Statistics

Last 12 Hours
Statistics
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Accessing the Real-time and Replay Modes

The two buttons located at the top of the Main Control Panel toggle between the Real-
time mode and the Replay modes.

Real-time Mode

The Real-time mode displays call center activity that spans the past
12-hours. Call center statistics are divided into three sections: Now,
Last Hour, and Last 12 Hours. Updated constantly, the Now statistics
provide a dynamic view of the current call center activity. The Last

Hour and Last 12 Hours reports provide a shift overview using the call center
statistics compiled over the selected time frame. When in the Real-time mode,
the application title bar states TASKE ACD Monitor, whereas the titlebar states
TASKE ACD Monitor - Replay when the application is functioning in the Replay
mode.

Using the features of the Real-time mode, call center management is simplified.
Agent and queue status is reported in real-time using a number of reporting
formats. These formats include the numerical display of Now statistics on the
Pilot Panel, a graphical view of the Now statistics, a tabular view of the agent
queue, and user-definable agent maps that allow users to group agents logically
while displaying their status.

The Last Hour and Last 12 Hours statistics provide material for shift evaluation.
Review service percentages, telephone service factors, queue traffic, and agent
performance. Reporting formats for the Last Hour and the Last 12 Hours include
the numerical display of the statistics on the Pilot Panel, a graph for each
statistic, a graphical performance evaluation of the agents by group, and an
agent utilization graph that displays the agent states for the last hour.

Replay Mode

The Replay mode is an animated review of a 24-hour period that
shares the reports of the Real-time mode. Using the same Now, Last
Hour, and Last 12 Hours reports, select a date with logged call center
data. As the replay progresses, the time indicates the time of day the

replay is displaying. The time is presented in 24-hour format and its speed of
progression depends on the replay speed. When in the Replay mode, the
application title bar states TASKE ACD Monitor - Replay, whereas the title bar
simply states TASKE ACD Monitor when the application is functioning in the
Real-time mode.

The Speed slider control determines the speed of the replay. At its slowest, the
data is replayed in real-time, where one second equals one second. At its fastest,
the data is replayed at 1000 times the real-time increments, meaning that one
millisecond equals one second. Between these two extremes, the replay speeds
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range from 2 times to 999 times the real-time increments. The speed is
changeable while the replay is in progress, allowing users to quickly move
through the information and slow it down when an in-depth analysis is required.

Located on the Main Control Panel, the controls for the replay are similar to that
of a VCR. Use the replay controls to maneuver throughout the day's data. To
further control the replay of data, select thresholds based on call center
conditions or a specific time of day that pause the replay when the selected
conditions are encountered.

Using the Pilot Panels to View Pilot Activity

The Pilot Panels are the access points for the information provided by the TASKE ACD
Monitor application. The graph control buttons on the Pilot Panels provide statistical and
performance information for Pilots based on queue and agent activity.

Pilot Panels present Pilot information via the graph control buttons. Those graph control
buttons that represent a call center statistic provide the numeric value of the statistic on
the button. Clicking any of the graph control buttons provides a report below the Pilot
Panel in the form of a bar graph or a table.

The graph control buttons are arranged on the Pilot Panels in three branches: Now,
Last Hour, and Last 12 Hours. Now is the top branch of graph control buttons and these
represent the current call center conditions. Last Hour is the middle branch of graph
control buttons and these represent the call center conditions over the last 60 minutes.
Last 12 Hours is the bottom branch of graph control buttons and these represent the call
center conditions over the past 12 hours.

Pilot Panels are selected for display on the Pilot Monitor List. When a Pilot Panel is
displayed, the Now branch of graph control buttons is visible and the name of the Pilot
or Pilot Group is presented in the top, left corner. The Now branch of graph control
buttons is always displayed, however, the Last Hour and Last 12 Hour branches are
hidden. These branches are collapsible and expandable to provide the information only
when needed. Click the Last Hour and Last 12 Hours icons to display or hide these
branches of graph control buttons.

An icon represents each button on the Pilot Panels. The Last Hour and Last 12 Hours
branches share the same icons, as the reports for both branches are the same. The
only difference is the time span of the reports.
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The Replay mode adds the Trigger button to the Now branch of graph control buttons.
This button allows users to select specific call center conditions that will stop the replay
when the selected conditions are encountered in the call center records.

Pilot Panel Icons

The icons on the Pilot Panels provide easy visual recognition of the call center
statistics. The table below defines each of the icons on the Pilot Panels.

Now

Displays the Last 12 Hours branch of statistics.

Displays the Last Hour branch of statistics.

Displays the time that the longest waiting caller has been waiting
and opens the Current States report.

Displays the number of calls currently waiting and opens the
Current States report.

Displays the number of agents on ACD calls and opens the Current
States report.

Displays the number of agents on non-ACD calls and opens the
Current States report.

Displays the number of agents logged in and opens the Current
States report.

Displays the number of agents available and opens the Current
States report.

Displays the number of agents idle and opens the Current States
report.

Displays the number of agents unavailable and opens the Current
States report.

Displays the number of agents logged out and opens the Current
States report.

Opens the Agent Queue report.

Opens the Agent Map report.

Opens the Pilot Triggers dialog box to set Trigger Stops for call
center conditions. Available only in Replay mode.
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Last Hour and Last 12 Hours

Displays the time of the longest waiting caller for the last hour and
opens the Longest Waiting Time report.

Displays the number of calls waiting for the last hour and opens the
Calls Waiting report.

Displays the number of calls answered for the last hour and the last
12 hours. Opens the Call Counts report.

Displays the number of calls interflowed for the last hour and the
last 12 hours. Opens the Call Counts report.

Displays the number of calls abandoned for the last hour and the
last 12 hours. Opens the Call Counts report.

Displays the Answer Service Percentage for the last hour and the
last 12 hours. Opens the Service Factors report.

Displays the Telephone Service Factor for the last hour and the last
12 hours. Opens the Service Factors report.

Displays the average time to answer for the last hour and the last 12
hours. Opens the Average Time to Answer report.

Displays the maximum time to answer for the last hour and the last
12 hours. Opens the Average Time to Answer report.

Displays the average time to abandon for the last hour and the last
12 hours. Opens the Average Time to Abandon report.

Displays the average talk time for the last hour and the last 12
hours. Opens the Average Talk Time report.

Displays the average time to interflow for the last hour and the last
12 hours. Opens the Average Time to Interflow report.

Opens the Answered by Group report for the last hour and the last
12 hours.

Opens the Agent Utilization report for the last hour.

Viewing Pilot Information

The Pilot Monitor List on the Main Control Panel provides an easy way to select
one or more Pilots or Pilot Groups to display.

To select one or more Pilot(s) or Pilot Group(s):

1. Click the Pilot(s)  and Pilot Group(s)  of interest on the Pilot Monitor
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List.
2. The pilot panels for the selected Pilot(s) and Pilot Group(s) open in the

PIDA.
3. De-select a Pilot or Pilot Group by clicking it a second time.

To select Pilots and Pilot Groups for monitoring:

To select a range of Pilots/Groups to toggle on or
off, SHIFT- or CTRL-click the range of
Pilots/Groups from the list and click the Toggle
button. Selected Pilots/Groups are highlighted in
blue.

Pilots/Groups are identified by their ID or nick name in the TASKE ACD Monitor.
To have the Pilots/Groups identified by their nicknames, enable the Use nick
name for monitoring check box. If this check box is disabled, the Pilots/Groups
are identified by their IDs.

It is important to note that the creation, deletion, and modification of Pilots and
Pilot Groups are controlled by the TASKE Administrator application. Contact your
administrator to further customize the list of available Pilots and Pilot Groups.

Using the Now Reports

Real-time call center information is represented by the Now branch of graph control
buttons. The graph control buttons that provide statistical information on the buttons
open the Current States report. This is a bar graph that provides all of the Now
statistical information on one graph. The Queue button opens the Agent Queue
report, a table that reports the current status of all agents in the Pilot or Pilot Group.
The Map button opens user-defined agent maps that provide agent state
information. Use these maps to create a custom layout that groups agents according
to the preferences of the user. For instance, create a map layout that groups agents
according to their seating position in the call center.

Viewing the Current States Report

The Current States report is a bar graph that includes all of the real-time statistics
on the Now branch of graph control buttons. Clicking any of the Now buttons
opens the Current States report. The time of the Longest Waiting Call is
displayed numerically in the margin of the graph and the remaining statistics are

1. Click the Pilots/Groups button
2. Enable the check box next to the Pilots or

Pilot Groups that you want to display in
the Pilot Monitor List.

3. Click OK.
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represented by bars in the graph. The real-time statistics provide both queue and
agent status information. These statistics are:

� the time of the longest call waiting
� the number of calls waiting
� the number of agents on ACD calls
� the number of agents on non-ACD calls
� the number of agents logged on
� the number of agents available
� the number of agents idle
� the number of agents unavailable
� the number of agents logged out

The information on the Current States report is provided in real-time. This means
that it is a dynamic report, changing as the agent states and the queue change.

The Current States report is opened by clicking the graph control button for any
of the statistics represented on the graph. When the report is open, the graph
control buttons for the statistics represented in the graph are depressed. Clicking
these buttons when they are depressed closes the Current States report.

Viewing the Agent Queue Report

Clicking the Queue button opens the Agent Queue report. This is a read-only,
tabular display that reports real-time agent activity for the Pilot or Pilot Group.
The five agent states included in the table are Idle Agents, On ACD Calls, On
Non-ACD Calls, Unavailable, and Logged Out. All agents in the Pilot or Pilot
Group are included and as their states change, it is reflected by their placement
in the table.
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The report is displayed in the PIDA and the table is organized into five columns,
each based on one or more agent states. In the title bar of each column, a
number is provided in brackets. This number indicates the number of agents
currently in that state.

The cells in the Agent Queue report provide agent and agent state information.
The amount of information displayed in the cells is dependent on the filters
selected by the user. In all cases the exact state can be identified using the agent
state character. The agent states and their characters are as follows:

I = Agent is Idle (waiting to be offered a call)
A = Agent is on an ACD call
P = Agent in on an inbound non-ACD call
O = Agent is on an outbound non-ACD call
H = Agent is on hold
W = Agent is in Work Time
M = Agent is in Make Busy
D = Agent is in Do Not Disturb
L = Agent is logged out
? = Agent is inactive (no activity has occurred since log in)

The Idle (I) and ACD (A) columns in the Agent Queue table are all very specific in
regard to the state that is reported. The Non-ACD column reports both inbound
(P) and outbound (O) non-ACD calls, the Logged Out column displays both the
logged out (L) and inactive (?) states while the Unavailable column reports the
remaining agent states.

Filtering cell information using the Cell Properties

Each cell in the Agent Queue report can display up to six items.
These items are: an agent state icon, the agent ID, the agent
name, the agent nick name, a state character, and the amount of
time the agent has spent in the current state. Users can choose to
display all or none of these items in the cells. By default, the agent

state icon, agent ID, agent name, and the amount of time the agent has spent in
the current state are displayed.

To select or de-select the agent properties for display:

1. Right-click anywhere on the map layout to access the cell properties drop-
down menu.

2. Click an item to select it or de-select it from the list of properties to display.
If a check mark is present beside the item, it is selected. If a check mark is
not present beside the item, it is not selected.

3. Repeat steps 1 and 2 for the selection or de-selection of additional items.

It is important to note that the properties cannot be changed for individual agents.
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Changing the display properties in a cell affects the information display for all of
the cells in the table.

Using color to display agent states
The use of color in the Agent Queue report is very effective for a quick analysis
of agent states. To further enhance the use of color in the Agent Queue report,
users can enable the color display for some states and disable the color display
for others using the State Color Legend.

To enable or disable the color display of agent states:

1. Right-click anywhere on the Agent Queue report to access the cell
properties drop-down menu.

2. Enable the View Legend option to open the State Color Legend dialog
box.

3. Enable the check boxes of the agent states that will display color.
4. Disable the check boxes of the agent states that will not display color.
5. Click  to close the State Color Legend dialog box.

When the color display for an agent state is disabled, the cell color is white.

Viewing the Agent Maps

The Agent Map is a real-time graphical report that dynamically illustrates the
status of agents. Agents are grouped on the Agent Map logically and their status
is reported using a combination of color, icons, and text. The ability to group
agents by department or by seating placement within the call center translates
into quick and easy personnel tracking and management.

A default Agent Map is created for each monitored Pilot that is titled: Main Map
for Pilot Name. This Agent Map is a shell only. Users must place agents on the
map, edit the title if desired, and set the preferences.

Clicking the Map button on a Pilot Panel displays the last viewed agent map for
the Pilot in the PIDA. The agent map consists of a toolbar and a grid area that
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displays the selected map layout. The toolbar contains three buttons that access
the map layouts and their setup. The Agent Maps button accesses the map
layouts, the Map Legend button accesses the color legend for the agent states,
and the Agent List button accesses the list of agents in the Pilot.
The grid in the Agent Map is where the agents are grouped. The grid can be as
small as one cell or as large as thirty rows by 30 columns, or nine hundred cells.
The cell size is scaled to accommodate the grid size, meaning that smaller grids
have larger cells that can display more agent information.

Agents can be grouped in any order, with blank cells surrounding each group for
easy group recognition. The cells can display an agent state icon, the agent ID,
the agent name, a character that represents the state, and the amount of time
the agent has been in the state. This information can be filtered to display only
the information that is pertinent to the user.

Creating, modifying, and deleting map layouts
The Agent Maps... button opens the Agent Maps
dialog box where map layouts are created and
modified. Several map layouts can be created for
each Pilot or Pilot Group, allowing custom map
layouts to be created that reflect the individual
preferences of the users.

To create a new map layout:

1. Click Agent Maps... on the toolbar to open the Agent Maps dialog box.
2. Click New to add a new map layout to the list.
3. Type a name for the new map layout in the Map Name column.
4. Click the Rows column and input the number of rows for the table.
5. Click the Columns column and input the number of columns for the table.
6. Click Update to save the new map layout.

To edit an existing map layout:

1. Click Agent Maps... on the toolbar to open the Agent Maps dialog box.
2. Change the map layout name in the Map Name column if required.
3. Click the Rows column and change the number of rows for the table if

required.
4. Click the Columns column and change the number of columns for the

table if required.
5. Click Update to save the changes to the map layout.

It is important to note that removing occupied cells from the grid by reducing the
grid size automatically removes the agents occupying the cells from the grid and
returns the agent names to the Agent List.
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To delete a map layout:

1. Click Agent Maps... on the toolbar to open the Agent Maps dialog box.
2. Enable the check box of the map layout to delete.
3. Click Delete to open the TASKE ACD Monitor dialog box.
4. Click Yes to delete the map layout.

Adding and removing agents from a map layout
A drag-and-drop feature is used to add agents to and remove agents from a map
layout.

To place an agent in a map layout:

1. Click Agent List... on the toolbar to open the Agent List dialog box.
2. Drag an agent from the Agent List to an empty cell in the Agent Map.

To move an agent to another cell:

1. Click the cell occupied by the agent to be moved. When selected, a box
surrounds the agent information in the cell.

2. Move the mouse to a corner of the cell until the mouse pointer becomes a

.
3. Drag the agent to the desired cell.

To remove an agent from a map layout:

Adding or moving an agent to an occupied cell removes the agent occupying the
cell from the grid and returns the agent name to the Agent List.

Switching between map layouts
The map layouts for individual Pilots or Pilot Groups are accessed via the Map
button on the Pilot Panels. Several map layouts can exist for a single Pilot or
Pilot Group. This allows custom maps to be created for each call center shift that
reflect the individual preferences of the users.

1. Click Agent List... on the toolbar to open the Agent List
dialog box.

2. Click the cell occupied by the agent to be removed.
When selected, a box surrounds the agent information
in the cell.

3. Move the mouse to a corner of the cell until the mouse

pointer becomes a .
4. Drag the agent to the Agent List.
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To switch between map layouts:

1. Click Agent Maps... on the toolbar to open the Agent Maps dialog box.
2. Enable the check box for the desired map layout.
3. Click Close to close the Agent Maps dialog box.

Filtering cell information using the Cell Properties

Each cell in a map layout can display up to six items. These items are: an agent
state icon, the agent ID, the agent name, the agent nick name, a state character,
and the amount of time the agent has spent in the current state. Users can
choose to display all or none of these items in the cells of a map layout. By
default, the agent state icon, agent ID, agent name, and the amount of time the
agent has spent in the current state are displayed.

To select or de-select the agent properties to display in a cell:

1. Right-click anywhere on the map layout to access the cell properties drop-
down menu.

2. Click an item to select it or de-select it from the list of properties to display.
If a check mark is present beside the item, it is selected. If a check mark is
not present beside the item, it is not selected.

3. Repeat steps 1 and 2 for the selection or de-selection of additional items.

The bottom two items in the cell properties drop-down menu
open and close the State Color Legend dialog box and the
Agent List dialog box.

Properties cannot be changed for individual agents. Changing
the display properties in a map layout affects the information
display for all agents in the map layout.

Using color to display agent states

The use of color in the Agent Map is very effective for a
quick analysis of agent states. To further enhance the
use of color in the Agent Maps, users can enable the
color option for some states and disable the color
options for others using the Map Legend.

Click the Map Legend... button on the toolbar or right-
click the grid and select View Legend from the pop-up
menu to open the State Legend dialog box. Using this
dialog box, users can disable the color display for
states that are not important. This makes the states
with the color display enabled become more evident
when they are encountered.
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To enable or disable the color display of agent states:

1. Click Map Legend... on the toolbar or right-click the grid and select View
Legend from the menu to open the State Legend dialog box.

2. Enable the check boxes of the agent states that will display color.
3. Disable the check boxes of the agent states that will not display color.
4. Click  to close the State Legend dialog box.

When the color display for an agent state is disabled, the cell color is white.

Using the Last Hour and Last 12 Hours Reports

The Last Hour and Last 12 Hours reports are accessed via the Now branch of graph
control buttons on the Pilot Panels. Clicking the  button on the Now branch of a Pilot
Panel accesses the Last Hour branch of reports, while clicking the  button accesses
the Last 12 Hours branch of reports. These branches are collapsible and expandable to
provide the information only when needed.

Each Last Hour and Last 12 Hours report is represented by a graph control button. If
applicable, the button displays the numeric value of the statistic it represents. The
Longest Waiting Time, Calls Waiting, and the Agent Utilization reports are only available
for the last hour. The remainder of the reports are the same for the Last Hour and Last
12 Hours, except for the time frame involved.

Clicking a graph control button on either the Last Hour or Last 12 Hours branch of
reports displays the report below the Pilot Panel. When more than one graph control
button is depressed, all of the statistics for the depressed buttons are present on the
displayed graph. Clicking a depressed graph control button closes the report.

The reports that present the Last Hour and the Last 12 Hours statistics are:

� Longest Waiting Time
� Calls Waiting
� Call Counts
� Service Factors
� Average Time to Answer
� Average Time to Abandon
� Average Talk Time
� Average Time to Interflow
� Answered By Group
� Agent Utilization

To get detailed statistical information about any of the bars on any of the graphs, hold
the mouse over the bar for a moment to produce the statistical information.
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Using the Longest Waiting Time Report

The Longest Waiting Time report is a bar graph that indicates the amount of time
the longest waiting caller has been in the pilot or pilot group queue for each
minute of the last hour. Segmented into one-minute intervals, the graph updates
once every minute.

To view the Longest Waiting Time report:

1. Select the Pilot or Pilot Group that interests you from the Pilot Monitor List.
2. On the Pilot Panel that appears, enable the Last Hour  button.
3. Click the Longest Waiting Time  button on the Last Hour branch of

graph control buttons.

Using the Calls Waiting Report

The Calls Waiting report is a bar graph that details the number of calls waiting in
the queue for the Pilot or Pilot Group over the past hour. Segmented into one-
minute intervals, the graph updates once every minute with the most recent
count of calls in the queue.

To view the Calls Waiting report:

1. Select the Pilot or Pilot Group that interests you from the Pilot Monitor List.
2. On the Pilot Panel that appears, enable the Last Hour  button.
3. Click the Calls Waiting  button on the Last Hour branch of graph control

buttons.

Using the Call Counts Report

The Call Counts report is a bar graph that provides the number of calls
answered, the number of calls abandoned, and the number of calls interflowed.
The graph is available for the last hour and the last 12 hours. The last hour graph
is segmented into 15-minute periods and the last 12 hours graph is segmented
into 2.5-hour periods. Both graphs are continually updated with the most recently
completed 15-minute period.

To view the Call Counts report for the last hour:

1. Select the Pilot or Pilot Group that interests you from the Pilot Monitor List.
2. On the Pilot Panel that appears, enable the Last Hour  button.
3. Click either the Calls Answered  button, the Calls Abandoned  button,

or the Calls Interflowed  button on the Last Hour branch of graph control
buttons.
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To view the Call Counts report for the last 12 hours:

1. Select the Pilot or Pilot Group that interests you from the Pilot Monitor List.
2. On the Pilot Panel for the selected Pilot or Pilot Group, enable the Last 12

Hours  button.
3. Click either the Calls Answered  button, the Calls Abandoned  button,

or the Calls Interflowed  button on the Last 12 Hours branch of graph
control buttons.

Using the Service Factors Report

The Service Factors report is a bar graph that reports the Answer Service Factor
and Telephone Service Factor. These statistics indicate how the calls that reach
the call center are being handled. The graph is available for the last hour and the
last 12 hours. The last hour graph is segmented into 15-minute periods and the
last 12 hours graph is segmented into 2.5-hour periods. Both graphs are
continually updated with the most recently completed 15-minute period.

The Telephone Service Factor indicates the percentage of calls answered and
abandoned before the maximum time to answer threshold is exceeded. Ideally
this value would be 100%. It is desirable to keep this parameter as high as
possible, so a significant number of calls are responded to before the threshold
target is reached.

The Answer Service Factor is the percentage of calls answered, irrespective of
the time it takes to answer them. Ideally this value would be 100%. It is desirable
to keep this parameter as high as possible so a significant number of calls are
answered rather than abandoned.

To view the Service Factors report for the last hour:

1. Select the Pilot or Pilot Group that interests you from the Pilot Monitor List.
2. On the Pilot Panel that appears, enable the Last Hour  button.
3. Click either the Answer Service Factor  button or the Telephone

Service Factor  button on the Last Hour branch of graph control
buttons.

To view the Service Factors report for the last 12 hours:

1. Select the Pilot or Pilot Group that interests you from the Pilot Monitor List.
2. On the Pilot Panel that appears, enable the Last 12 Hours  button.
3. Click either the Answer Service Factor  button or the Telephone

Service Factor  button on the Last 12 Hours branch of graph control
buttons.
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Using the Average Time to Answer Report

The Average Time to Answer report is a stacked bar graph that provides the
average time to answer and the maximum time to answer. The graph is available
for the last hour and the last 12 hours. The last hour graph is segmented into 15-
minute periods and the last 12 hours graph is segmented into 2.5-hour periods.
Both graphs are continually updated with the most recently completed 15-minute
period.

To view the Average Time to Answer report for the last hour:

1. Select the Pilot or Pilot Group that interests you from the Pilot Monitor List.
2. On the Pilot Panel that appears, enable the Last Hour  button.
3. Click either the Average Time to Answer  button or the Maximum Time

to Answer  button on the Last Hour branch of graph control buttons.

To view the Average Time to Answer report for the last 12 hours:

1. Select the Pilot or Pilot Group that interests you from the Pilot Monitor List.
2. On the Pilot Panel that appears, enable the Last 12 Hours  button.
3. Click either the Average Time to Answer  button or the Maximum Time

to Answer  button on the Last 12 Hours branch of graph control
buttons.

Using the Average Time to Abandon Report

The Average Time to Abandon report is a bar graph that provides the average
amount of time a caller will wait in the queue for the Pilot or Pilot Group without
an answer. The graph is available for the last hour and the last 12 hours. The last
hour graph is segmented into 15-minute periods and the last 12 hours graph is
segmented into 2.5-hour periods. Both graphs are continually updated with the
most recently completed 15-minute period.

To view the Average Time to Abandon report for the last hour:

1. Select the Pilot or Pilot Group that interests you from the Pilot Monitor List.
2. On the Pilot Panel that appears, enable the Last Hour  button.
3. Click the Average Time to Abandon  button on the Last Hour branch of

graph control buttons.

To view the Average Time to Abandon report for the last 12 hours

1. Select the Pilot or Pilot Group that interests you from the Pilot Monitor List.
2. On the Pilot Panel that appears, enable the Last 12 Hours  button.
3. Click the Average Time to Abandon  button on the Last 12 Hours
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branch of graph control buttons.

Using the Average Talk Time Report

The Average Talk Time report is a bar graph that provides the average length of
answered calls for the Pilot or Pilot Group. The graph is available for the last hour
and the last 12 hours. The last hour graph is segmented into 15-minute periods
and the last 12 hours graph is segmented into 2.5-hour periods. Both graphs are
continually updated with the most recently completed 15-minute period.

To view the Average Talk Time report for the last hour:

1. Select the Pilot or Pilot Group that interests you from the Pilot Monitor List.
2. On the Pilot Panel that appears, enable the Last Hour  button.
3. Click the Average Talk Time  button on the Last Hour branch of graph

control buttons.

To view the Average Talk Time report for the last 12 hours:

1. Select the Pilot or Pilot Group that interests you from the Pilot Monitor List.
2. On the Pilot Panel that appears, enable the Last 12 Hours  button.
3. Click the Average Talk Time  button on the Last 12 Hours branch of

graph control buttons.

Using the Average Time to Interflow Report

The Average Time to Interflow report is a bar graph that provides the average
length of time a call will remain in the Pilot or Pilot Group queue before being
routed to another queue. The graph is available for the last hour and the last 12
hours. The last hour graph is segmented into 15-minute periods and the last 12
hours graph is segmented into 2.5-hour periods. Both graphs are continually
updated with the most recently completed 15-minute period.

To view the Average Interflow Time report for the last hour:

1. Select the Pilot or Pilot Group that interests you from the Pilot Monitor List.
2. On the Pilot Panel that appears, enable the Last Hour  button.
3. Click the Average Time to Interflow  button on the Last Hour branch of

graph control buttons.

To view the Average Interflow Time report for the last 12 hours:

1. Select the Pilot or Pilot Group that interests you from the Pilot Monitor List.
2. On the Pilot Panel that appears, enable the Last 12 Hours  button.
3. Click the Average Time to Interflow  button on the Last 12 Hours
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branch of graph control buttons.

Using the Answered by Group Report

The Answered by Group report is a bar graph that indicates the percentage of
calls handled by each Agent Group within the Pilot or Pilot Group. The graph is
available for the last hour and the last 12 hours. The last hour graph is
segmented into 15-minute periods and the last 12 hours graph is segmented into
2.5-hour periods. Both graphs are continually updated with the most recently
completed 15-minute period.

To view the Answered by Group report for the last hour:

1. Select the Pilot or Pilot Group that interests you from the Pilot Monitor List.
2. On the Pilot Panel that appears, enable the Last Hour  button.
3. Click the Answered by Group  button on the Last Hour branch of

graph control buttons.

To view the Answered by Group report for the last 12 hours:

1. Select the Pilot or Pilot Group that interests you from the Pilot Monitor List.
2. On the Pilot Panel that appears, enable the Last 12 Hours  button.
3. Click the Answered by Group  button on the Last 12 Hours branch of

graph control buttons.

Using the Agent Utilization Report

The Agent Utilization report is a bar graph that indicates the agent states and the
number of agents in each state for the last hour. The graph includes the number
of agents idle, the number of agents on ACD calls, the number of agents on non-
ACD calls, and the number of agents unavailable. Segmented into twenty-minute
intervals, the graph updates once every minute with the most recent agent state
information.

To view the Agent Utilization report:

1. Select the Pilot or Pilot Group that interests you from the Pilot Monitor List.
2. On the Pilot Panel that appears, enable the Last Hour  button.
3. Click the Agent Utilization  button on the Last Hour branch of graph

control buttons.

Using the Replay Mode

The Replay mode uses stored PBX data to provide an as-it-happened repetition
of a selected 24-hour period. The replay of call center data is controlled in a
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manner similar to that of a VCR. Use the replay controls to maneuver throughout the
data for the selected day. Prior to playing the data, select the date for the replay and set
the replay speed to an adequate level.

The controls for the Replay mode are located on the Main Control
Panel. Use the controls to select the replay date and speed, and to
control the progression of the information. In addition, a time of day
Trigger Stop can be set using the Trigger Stops button on the Main
Control Panel. To set Pilot or Pilot Group specific Trigger Stops that
apply to call center conditions, use the Trigger Stops buttons on the
Pilot Panels.

Starting the replay

Clicking the  button starts the playback of call center data. The speed of the
data replay is determined by the selection in the Speed field.

Pausing the replay

To pause the replay, click the  button. When the replay is paused, the time field
flashes the time the replay was paused. Click Pause again or Play to restart the
replay.

Stopping the replay

Clicking the  button stops the replay and resets the time to 00:00 for the
selected date.

Fast forwarding the replay

Clicking the  button immediately advances the replay to the next event. Clicking
and holding the button continues to advance through the events until the button
is released.

Using the hourly placeholder buttons

As a replay progresses, the information is saved at the beginning of each hour.
When a save occurs, a temporary marker, or placeholder, is created. The  and

 buttons are used to move from placeholder to placeholder when the replay is
paused. When the  button is clicked, the replay time returns to 00:00 and all
markers are removed.

Setting Trigger Stops

Use the Trigger buttons on the Main Control Panel and on the Pilot Panels to
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define time of day and queue events that pause the replay when encountered.

Known as Trigger Stops, the thresholds for call center conditions are selected for
individual Pilots or Pilot Groups using the Trigger button on the Pilot Panel.
Thresholds can be set for three call center conditions. These are Calls Waiting,
Abandoned Calls, and the Longest Waiting Call. The time of day Trigger Stop is
a general threshold that applies to all monitored Pilots and Pilot Groups. Only
one time of day trigger stop can be set at a time.

To define Trigger Stops for call center conditions:

1. Click the Trigger button on the Pilot Panel for the desired Pilot or Pilot
Group to open the Pilot Triggers dialog box.

2. Enable the check boxes for the desired Trigger Stops and set the value or
time thresholds for each.

3. Click OK.

To define a time of day Trigger Stop:

1. Select the Trigger button on the Main Control Panel to open the Trigger
dialog box.

2. Enable the Stop at Record Time (HH:MM:SS) check box and set the time
for the Trigger Stop.

3. Click OK.

Setting the replay speed

The replay speed is set using the speed slider control on the Main Control Panel.
At its right-most position, or slowest replay speed, the data is replayed in real-
time, where one second equals one second. At its left-most position, or fastest
replay speed, the data is replayed at 1000 times the real-time increments,
meaning that one millisecond equals one second. Between these two extremes,
the replay speeds range from 2 times to 999 times the real-time increments. The
speed is changeable while the replay is in progress, allowing users to quickly
move through the information and slow it down when an in-depth analysis is
required.

To select a replay speed:

1. Move the slider to the desired position within the replay speed range.
2. Adjust the slider at any time during the replay.

Selecting the replay date

To replay call center data, the user must select a date from the date box on the
Main Control Panel.
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To select the replay date:

1. Double-click the date box to open the calendar in the Date Selection
dialog box.

2. Use  and  to select the desired year.
3. Use  and  to select the desired month.
4. Click on each of the desired date(s). When a date is selected it is

highlighted in blue.
5. Click OK.
6. Click  to begin the replay.
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